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1: About these exercises

The Getting Started exercises provide an overview of the key tools and features in Ansys Granta EduPack, and form a set
of tutorials to help you familiarize yourself with the software. You can choose whether to work through them in order, or
complete only the exercises relevant to you.

There are also Getting Started video tutorials for Granta EduPack. These can be used independently of the exercises, or
alongside them, to test and check your knowledge.

This set of exercises covers themain tools and features available in Granta EduPack and Granta EduPack Introductory or
later. Earlier versions may give different results, or not include all features.

In this document:

1. Each step of the exercises is numbered, like this.

More detailed instructions appear below the main instruction.

2. Text on elements in the software (such as buttons, dialogs and tabs) appears in bold, like this. The names of records,
datatables, and documents are emphasized like this. Words and numbers that you type as you follow the instructions
appear in monotype, like this.

1.1. More resources to help you get started
For help using the software, or resources for teaching and learning, try:

FAQs:Ansys LearningLearn OnlineGranta EduPack Help

If you can’t find the answer to your question above, email us at education@ansys.com.
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2: About Granta EduPack

2.1. Main features and tools
Themain tools in Granta EduPack and Granta EduPack Introductory are:

Explore the database and retrieve records via a hierarchical index or tree.
Browse

Find information via a full-text search of records.
Search:

The central hub of Granta EduPack, used to apply the systematic material selection
methodology. A powerful selection engine that identifies records thatmeet an array
of design criteria and enables trade-offs between competing objectives.

Select:

Create charts and add formatting and labels to illustrate your point.
Chart:

Quickly estimate the energy usage and climate change (CO2-eq) of a product over its
entire lifecycle, and study What If design scenarios.Eco Audit:

The following tools and features are enabled in all advanced Level 3 databases included in Granta EduPack (for
example, Level 3 Aerospace and Level 3 Eco Design, but not Level 3):

The enhanced version of the tool also accounts for Secondary, Joining, and
Finishing processes, and includes a cost analysis.Enhanced Eco Audit:

Estimate performance ofmaterials bymodeling new hybridmaterials, battery
packs, or the part cost of a design; and compare these results with existing
records.

Synthesizer:

Quickly calculate the required strength, stiffness or Shape Factor for a given
design, and include them in a Limit Stage.Engineering Solver:

Select materials based on how similar their properties are to a Reference
record.

Find Similar:

Compare up to 20 records side-by-side, and highlight the differences in their

material properties from a Reference record.
Comparison Tables:

Easily record and summarise your complex selection project with an
automatically generated report.Selection Reports:

The exercises for these advanced features are designed so that Introductory users can simply skip them. You will
also be prompted to change databases to one that supports the feature.

2.2. Chart toolbar guide
The chart toolbar is displayed between the stage title and chart area on the Chart tab.
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* Highlight Reference record and Highlight synthesized records are not available in Granta EduPack
Introductory, and the icon will always be grayed out.
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3: Browsing and Searching

3.1. Exercise 1: Opening a database
On starting Granta EduPack, the Databaseswindowwill appear, showing all installed databases. The following
exercisesuse theMaterialUniverseandProcessUniverse tables,whichare foundwithin all Grantamaterial databases.
After clicking on a database name in theDatabaseswindow to select it, the Homepage then opens to show a list of
the available tables and a graphic for each subset.

From the homepage you can viewmore information on the database, select a subset, and access online resources
for students and educators.

1. Select the Level 2 database

If a feature used in an exercise is not enabled in the Level 2 database, you are asked to change to one that does
as part of the exercise. Results and images may differ if you complete an exercise using a different database.

2. Read about the available data and applications
a) Click Database information to view a detailed description of the database.
b) Click the Back arrow to return to the homepage.

3. Select a material subset
a) Click one of the subset icons, and notice that the Browse panel appears.

4. Change to the ProcessUniverse table
a) Click ProcessUniverse and notice that the Browse tree in the left panel updates.

5. Close the Homepage tab
a) Click the cross at the top of the Homepage tab. This page can be reopened at any time by clickingHome on

the main toolbar.

6. Change to theMaterialUniverse table
a) With the Homepage closed, navigate to different tables using the Table list in the Browse panel.
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3.2. Exercise 2: Browsematerial records
1. Select theMaterialUniverse table and the All Materials subset

2. Find the record for Stainless Steel
a) Double-click a folder in the browse tree to view the records and folders below it.

3. Open the folder-level record for Polymers

Folder-level records provide a general overview of a material family, rather than containing data on a specific
material. They have their own icon: .

4. Open the Polypropylene (PP) record
a) Double-click the record name in the tree to view the datasheet.

b) Click to view Science Notes for more information on the property and underlying science.
c) Right-click the datasheet to see a menu with further actions, for example: Locate in Browse tree, Copy or

Print the datasheet, and Duplicate Record.

5. Findprocesses that canshapePolypropylene, by clicking theProcessUniverse linkat thebottomof thedatasheet

9Release 2024 R1 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2023-11-24T07:20:32.985-05:00

Browsing and Searching



3.3. Exercise 3: Browse process records
1. Browse ProcessUniverse: All Processes

2. Find the record for the shaping process Injection molding, thermoplastics
3. Find the record for the surface treatment process Vapor metallizing (PVD)
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4. Find the record for the joining process Friction welding (metals)
5. Findmaterials that can be die cast, using the link toMaterialUniverse at the bottomof the datasheet forGravity

die casting

3.4. Exercise 4: Searching
1. Find the material Polylactide

2. Find the process Vacuum assisted resin transfer molding (VARTM)
3. Findmaterials used for "cutting tools"

The searchmatches text onadatasheet. For example, a search for"cutting tools"would returnall records
with the phrase "cutting tools" in the record description or supporting information.

4. Find the material Concrete
The searchmatches the record's folder name. If the search term appears in a folder name, all records under that
folder will be returned. For example, a search for concrete would return all records in the folder named Cement
and concrete e.g. Plaster of Paris.

5. Enter the search term alum*

Records containing the terms Alumina, Aluminum or Alumino are returned.

3.5. Advanced searches
The following search operators are available:

DescriptionOperator

Finds recordscontainingboththesearchterms, sosteel AND alloy
returns only records containing both the words steel and alloy

AND

Finds records containing either search term, so steel OR alloy
returns all records that contain steel, alloy, or both

OR

Finds records containing the first search term, but not the second, so
steel NOT alloy returns only records with the word steel but
without the word alloy

NOT

Finds the exact search term, so "steel alloy"will return only
records containing the exact phrase steel alloy

Phrase Search

Used to group search terms, so iron AND (ore OR cast)will
return the records containing iron and containing either ore, cast, or
both

Parentheses

Use ? as a wildcard single character, or * as a wildcard representing
any number of characters (these cannot be used as the first character
in a search string)

Wildcards
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Note: ANDoperators are automatically addedwhena searchhas twoormore termsandnoother operators
have been entered.



4: Creating property charts

Bar charts andbubble charts are a greatway to visualize and communicatematerial properties, aswell as being a key tool
to support systematic materials selection.

4.1. Exercise 5: Create a bar chart
1. SelectMaterialUniverse: All materials on the Chart/Select tab

a) Click Chart/Select, and then selectMaterialUniverse: All materials.

2. Create a bar chart of Young’s modulus (E)

a) Under Selection Stages, click Chart/Index.
b) Set the Y-axis attribute to Young's modulus, and clickOK.
c) For a bar chart, you do not set an X-axis: leave its attribute set to <None>.

3. Explore the chart

a) Click Zoom in and then drag to zoom in on an area of the chart.

b) Click Zoom out to zoom out.

c) Click Autoscale to zoom back to view the whole chart again.

4. Label records on the chart
a) Click a record on the chart and then drag to add and position a new data label.
b) To delete a data label, select it and press DELETE. To delete all labels in the chart, press CTRL+A and then

press DELETE.
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4.2. Exercise 6: Create a bubble chart
1. Make a bubble chart plotting Young’s modulus (E) against Density (ρ)

a) Under Selection Stages, click Chart/Index.
b) Set the Y-axis to Young’s modulus and set the X-axis to Density.
c) Leave the Axis Settings as default values to create a log-log plot.

2. Display family envelopes

a) Click Show Family Envelopes to look at how data for a given family of materials cluster together.

3. Label records on the chart
a) Hover the cursor over the record bubble to see the record name, and then label some records (click over a

record and drag).
b) Try adding labels from theResults list: right-click a record in the list, and select Label on the shortcutmenu,

then drag the label where you want it on the chart.

c) If the new label isn’t visible at the current zoom, click Autoscale to display the whole chart again.
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4. Delete this stage
a) Select the stage in the Selection Stages list and press DELETE.
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5: Filtering and screening

5.1. Exercise 7: Selection using a Chart Stage
When plotted on a Chart, records can also be filtered using the Index line and Box selection tools.

1. Create a bar chart of Yield strength (σy)
a) Set the Y-axis to Yield strength (elastic limit).

2. Use a Box selection to identify materials with high values of Yield strength

a) Click Box selection , then drag to define the selection box.

3. Add Density (ρ) to the X-axis

a) Click Chart Settings , then go to the X-Axis tab and select Density as the X-axis attribute. You can also
double-click the chart axis to open the dialog.

4. Use an Index line to identify materials with high values of specific strength, σy / ρ

a) Click Index and display lines .
b) Use the default Slope value of 1.
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c) The objective of the line is set toMaximize the index by default, which will result in selection of materials
above the line, for high values of σy / ρ.

d) ClickOK, then click the chart to position the line through a particular point.
e) Drag the line upwards to refine the selection to fewer materials.

5. Add a Box selection to the chart to identify materials with low Density that maximize the index.
6. Rank the Results list by specific strength (Yield strength / Density)

Show: Stage 1: Yield strength v. Density

Rank by: Stage 1: Index value.

Example results: Bamboo, Cork, Rigid Polymer Foam (MD).
7. Delete this stage

a) Select the stage in the Selection Stages list and press DELETE.

5.2. Exercise 8: Selection using a Limit Stage
1. Select materials with specific thermal and electrical properties.

a) Create a new Limit Stagewith the following criteria:

> 200 °CMaximum service temperature

> 25 W/m.°CThermal conductivity

> 1e15 μohm.cmElectrical resistivity

b) Use the limitbars forguidanceonsuitablevalues, andkeepAND logic selected.Enter the limits –minimum
or maximum as appropriate – and click Apply.

c) You can change the units on the datasheet by going to the Units tab under Settings.

Example results: Aluminum nitride, Alumina, Silicon nitride.
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2. Filter the results further to select only materials which are resistant to Hydrofluoric Acid (40%).
a) Under Durability: Acids, select Acceptable and Excellent for Hydrofluoric Acid (40%).
b) Click Apply. Silicon nitride should be the only passing record.

5.3. Exercise 9: Selection using a Tree Stage
Using a Tree Stage, you can filter records by category based on their links to records in other data tables, or based
on the database hierarchy (tree). For example, you can filter for records that are linked to a specific process record.

1. Findmaterials that can bemolded

a) Under Selection Stage, click Tree. In the Tree Stage dialog, select ProcessUniverse and navigate to
Molding.

b) Select the folder, click Insert, then clickOK.

2. Click Show to view a list of MaterialUniverse records to which this process folder is linked.
a) Double-click a record name to view its datasheet.
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3. Delete this stage.
4. Find processes which can join Ferrous Metals and alloys

a) In the Selection Project panel, under Selection Data, select ProcessUniverse: Joining.
b) In the Tree Stage dialog, selectMaterialUniverse, expandMetals and alloys, select Ferrous, and then click

Insert followed byOK.
c) Click Show to view the linked records.

5. Delete this stage.
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6: Putting it all together

6.1. Exercise 10: Combining filtering and charting tools

1. Choose the data table
a) Select from:MaterialUniverse: All materials.

2. Select materials with specific physical, mechanical, and thermal properties.
a) Create a Limit Stagewith the following criteria:

< 2000 kg/m^3Density

> 60 MPaYield strength (elastic limit)

< 10 W/m.°CThermal conductivity

3. Filter the results to find those that can be Thermoformed
a) CreateaTreeStageand InsertProcessUniverse > Shaping > Molding > Thermoplastic molding > Thermoforming.

4. Rank the results by Price and find the three cheapest materials
a) Create a Chart Stagewith a bar chart of Price on the Y-Axis. On the chart, all materials that fail one or more

stages are grayed out. The Results panel lists the materials that pass all stages by default.
b) In the Rank bymenu, select Stage 3: Price.

6.2. Exercise 11: Process selection
The Chart, Limit, and Tree selection stages can be used to filter ProcessUniverse records in the same way as for
MaterialUniverse.

1. Select the data table
a) Select from: ProcessUniverse: Shaping.
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2. Find Primary shaping processes to make a component with specific shape, physical, and economic properties.
a) Add a Limit Stagewith five criteria:

Dished sheetShape

10 - 12 kgMass range

4 mmRange of section thickness

Primary shaping processProcess characteristics

> 1000Economic batch size

3. Filter the results to only include Thermoplastic materials
a) Add a Tree Stage and Insert MaterialUniverse > Polymers and Elastomers > Polymers > Thermoplastic.

Example results: Rotational molding, Compression molding, Thermoforming

6.3.Exercise12:AdvancedselectionusingthePerformance IndexFinder

Note: The Performance Index Finder is only enabled in Level 3 databases.

ThePerformance IndexFinder is a toolwhich lets youplotperformance indicesonachart for agivendesign situation,
without having to derive an index from first principles.

In this exercise, you will use the Performance Index Finder to find the materials best suited for a beam, loaded in
bending, that is part of a low cost, lightweight, strength-limited design.

1. Select a Level 3 database and data table
a) Click Change... under Selection Data to change the database to Level 3.
b) Select from:MaterialUniverse: All bulk materials.

2. Create a chart using the Performance Index Finder
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a) Click Chart/Index, then select the Performance Index Finder radio button.

3. Enter the Component Definition for the Y-Axis

Beam in bendingFunction and Loading:

StrengthLimiting Constraint:

MassOptimize

Keep the default values for Free and Fixed Variables, and Axis Settings.

4. Enter the Component Definition for the X-Axis
a) Go to the X-Axis tab and select Performance Index Finder. Set the following values:

Beam in bendingFunction and Loading:

StrengthLimiting Constraint:

CostOptimize

Keep the default values for Free and Fixed Variables, and Axis Settings.

5. View the chart
a) ClickOK to view the chart.

Materials in the bottom-left corner are best suited for a lightweight, low cost, strength-limited design.

6. Delete this stage.

6.4. Exercise 13: Advanced selection with Comparison Tables

Note: Comparison Tables are only enabled in the advanced Level 3 databases. The option will be grayed
out or not appear at all if you have opened any of the databases available in Granta EduPack Introductory,
including Level 3.
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In industry, materials selection projects are often required to find a replacement for an existing material, due to
changes in the design or manufacture of the component, or because of supply chain issues. Comparison Tables
allow you to compare several different records at once, and highlight differences between them.

1. Change the database to one where Comparison Tables are enabled
a) Change the database and table to Level 3 Polymer, MaterialUniverse: All materials.

2. Add an unfilled PP (Polypropylene) and an unfilled high-density PE (Polyethylene) record to a Comparison Table.
a) Find an example of each in the Browse tree, then right-click and select Add to Comparison Table.

3. Set the high-density PE as the Reference record

a) Hover over the record name in the comparison table header and click Set as Reference .

Note: Reference record is another feature enabled in the advanced Level 3 databases. Setting a
Reference recordallows you toeasily identify it in thebrowse tree andoncharts, and compareother

records to it using Comparison Tables and Find Similar (see the next exercise and the software
Help for more information).

4. Show the differences relative to the Reference record as percentages
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a) Click Change in the Comparison Table toolbar.

Note: These are differences in the range values, not the averages.

5. Clear the Comparison Table and Reference record
a) Click Tools on the main toolbar, then select Comparison Table > Clear >MaterialUniverse. Repeat for the

Reference record.

6.5. Exercise 14: Advanced selection with Find Similar and Limit Stage

Note: Find Similar is only enabled in the advanced Level 3 databases. This exercise assumes you are
using the Level 3 Polymer database from the last exercise.

1. Open the record for Polypropylene (Copolymer, Conductive, 5% Carbon powder)
2. Find records similar to it

a) Click Find Similar at the top of the datasheet tab. Polypropylene (Copolymer, Conductive, 5% Carbon
powder) will become the Reference record.

b) Use the default weightings to calculate nearness - do not open Nearness Settings.

3. Compare the current material with the nearest alternative
a) Select one of the closest records from the list of results, PP (copolymer, 10% talc), and open a comparison

table by clicking Comparison...
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The Comparison Table is highlighted where there is a difference between the original (reference) and
alternative materials. The nearest materials in the results have similar physical properties to the reference
material (density, yield strength, Young’s modulus). However, the original material may have been chosen
for its other characteristics. In this case, the polymer is conductive (has a low electrical resistivity).

To find materials which have all the properties we need, we can proceed in one of two ways:

• Adjust the Nearness Settings to prioritise the material properties most important to our application (see
Exercise 15).

• Use the results from Find Similar as the basis of a Selection Project. In this case, you can use a Limit Stage
to filter on the additional requirement for conductivity.

4. Create a Selection Project using the results
a) In the Records similar to dialog, click Selection Project. The results are loaded into a new project, ranked

by nearness.

5. Filter the results for an Electrical resistivity that is equal to or lower than that of the reference material
a) CreateaLimitStage, andset themaximumvalue forElectrical resistivity to3.16e12,which is themaximum

value for the reference record. Apply the stage.
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Example results, with Nearness (%):

• PP (10-12%, stainless steel fiber) - 87%
• PP (10% carbon fiber) - 83%
• ABS (40% aluminum flake) - 79%

6. Delete this stage.

6.6. Exercise 15: Advanced selection with Find Similar and Nearness
Settings

Insteadof filteringonadditional attributes, you canchange the criteria used for calculatingnearness to takeaccount
of different requirements.

Note: Find Similar is only enabled in the advanced Level 3 databases. This exercise assumes you are
using the Level 3 Polymer database from the last exercise.

1. Find records similar to Polypropylene (Copolymer, Conductive, 5% Carbon powder)

a) Open the datasheet and click Find Similar.

2. Re-calculate the list of alternativematerials, taking Electrical resistivity into account and prioritizing results with
a resistivity that is the same or lower than the reference material
a) Click the Nearness settings link on the Records Similar to dialog.
b) Under Electrical Properties, select Electrical resistivity. Set it to 100%whenSameor lower, and increase

theWeighting factor to 2.
c) ClickOK to generate the new results.

Note: These results are conceptually different to those from the previous exercise. We have ranked
similarmaterials, taking intoaccount the resistivity, but there isnota fixedupper limit as therewaswhen
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filtering using the Limit Stage. Materials with a higher resistivity than the referencewill still be included
in these results.

6.7. Exercise 16: Calculate values for a Limit Stage using Engineering
Solver

Design requirements are often specified in termsof geometry, loading, andmaximumdeflections. TheEngineering
Solver tool converts these engineering requirements intomaterial properties, which can then be applied in a Limit
Stage to screen for suitable materials.

Note: Engineering Solver is only enabled in the advanced Level 3 databases. This exercise assumes you
are using the Level 3 Polymer database from the last exercise.

1. Open the Engineering Solver.

a) Click Solver on the main toolbar.

2. Select the loading geometry Beam in Bending

This model estimates the minimum strength, stiffness and Shape Factor values required for a beamwith the
specified geometry and load conditions.

3. Enter the geometry for an I-beamwith the following dimensions:
Use the Cross-section list to select I-section. Enter the following dimensions and
use the drop-down lists at the end of each line to select the correct units:

Breadth, b = 100mm; Depth, d = 250mm; Thickness, t = 10mm; Web thickness, tw=
10 mm; Length, l = 5 m.

4. Enter the design parameters for a cantilever with an end load of 5 kN

Load condition = Cantilever End load; Load = 5 kN; Safety factor = 1.5; Maximum deflection = 50 mm.

The results are populated automatically. You should see that theminimum required Young’s Modulus is 133 GPa
and the minimum Yield Strength is 108 MPa.

Keep the Engineering Solver dialog open.

5. Select materials based on the results from Engineering Solver
a) Create a new Limit stage usingMaterialUniverse: All bulk materials, and enter the minimum Young’s

modulus and Yield strength (elastic limit) estimated by the Solver. You can copy and paste from the dialog
using CTRL+C and CTRL+V.

b) Make sure the units in the Engineering Solver and Limit Stagematch. Change the results units in the
Engineering Solver dialog if they do not.

Over a thirdof thematerials in thedatabasemeet the requirements. Typically, youwouldapplymoreconstraints
and selection stages to narrow the list further.

6. Delete this stage, and Change database back to Level 2
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7: Saving, copying, and report writing

7.1. Exercise 17: Adding comments and saving a project
You can add comments (Notes) to a selection project as a reminder ofwhy you have applied certain constraints and
objectives. Comments are displayed onmouse-over in the stage tab, and are saved in the project file.

Notes can be added to each selection stage as below, or to the overall project (in Project Settings).

1. Click Notes in the stage window heading to open the Stage Settings dialog, then enter some comments in
the Notes box.

2. Save your project
Select File > Save Project. Give the project a filename and folder location; the project will be saved with the file
extension .ces.

7.2. Exercise 18: Copying charts, data and results lists
Charts, records, and results lists canbecopiedandpasted intoadocument in another application suchasMicrosoft

®

Word, Microsoft Excel, Microsoft Powerpoint, or Notepad.

1. Copy a chart into a document
a) To copy a chart to the clipboard: in the chart window, right-click the chart and select Copy on the shortcut

menu, or press CTRL+C.
b) You can then paste the chart image from your clipboard into the document as a device-independent bitmap.

2. Copy a datasheet into a document
a) To copy a datasheet to the clipboard: display the datasheet, then right-click the datasheet and select Copy

on the shortcut menu, or press CTRL+C.
b) You can then paste the data from your clipboard into the document.

3. Copy results into a document
a) To copy results to the clipboard, use SHIFT+click or CTRL+click to highlight the records you want,

then right-click and select Copy on the shortcut menu, or press CTRL+C.
b) To select all results in the list, right-click and select Select All on the shortcut menu, or press CTRL+A.
c) You can then paste the results from your clipboard into the document.
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4. Edit the document you have created

7.3. Exercise 19: Exporting Selection Reports

Note: Selection Reports are only enabled in the advanced Level 3 databases (e.g Level 3 Eco Design). The
option will not appear if you have opened any of the databases available in Granta EduPack Introductory,
including Level 3.

1. Generate a Selection Report

a) Click Selection at the bottom of the Chart/Select pane.

2. Export the report as a PDF
a) Click Export and select PDF. Selection Reports can be exported as a PDF, a Microsoft

®
Word document,

or a Microsoft Excel spreadsheet.
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8: Eco Audit tool

The Eco Audit tool estimates the energy used and CO2 produced during the four key life phases of a product (material,
manufacture, use, and end of life) and transport, and identifies which phase has the dominant contribution. This is the
startingpoint foreco-awareproductdesign,as it identifieswhichparametersneed tobe targeted to reduce theeco-footprint
of the product.

Thenext fewexerciseswill take you througha case study for abrandof bottledmineralwater. It is sold in 1 liter PETbottles
with polypropylene caps. A bottle weighs 40 grams, the cap weighs 1 gram. Bottles and caps are molded, filled, and
transported 550 km from the French Alps to England by a 7.5-16 tonne truck, refrigerated for 2 days and then sold. The
overall life of the bottle is one year.

An example product file for this case study is installed with Granta EduPack in the Samples folder, with the filename Level
2 - Bottle PET.prd. Eco Audit .prd files can only be opened and saved from the Eco Audit tab, and are saved separately from
selection project files (.ces).

Note: The Enhanced Eco Audit tool contains warnings about restricted substances, and options to include a

cost analysis or a secondary process in the audit. For more information on these advanced features, see the
Help or the teaching resources on Granta’s Education Hub.

8.1. Exercise 20: Define and audit a product

To view an explanation of the calculations used at each stage, click the Help icon in the header.

1. Enter material, manufacture, and end of life details

Bill of materials (BoM) and primary processing method.
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2. Enter transport details

Transportation from site of manufacture to point of sale.

3. Enter Product life and Country of use

Expected product lifetime and geographic region where it will be used.

4. Enter details of energy consumption during product use

Energy is used to refrigerate the product at point of sale (average energy required to refrigerate 100 bottles at
4°C = 0.12kW). Enter this under Static Mode.

(This product is not part of a vehicle, so there is noMobile Mode entry.)

5. View the Summary Chart and Eco Audit Report

Click Summary chart. The chart enables rapid identification of the dominant life phase. Toggle between plots
of energy usage or Climate change (CO2-eq).

For thisproduct,Material is thedominant lifephase. Each lifephase canbeclicked to showguidanceonstrategies
to reduce its impact.
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Click Detailed report to view a component-by-component breakdown of each life phase. The Report can be
saved as a PDF or Word document.

8.2. Exercise 21: Compare products with Eco Audit
This exercise assumes you have completed Exercise 20: Define and audit a product on page 30.

1. Create a copy of your product for comparison
a) Click Compare with on the Product Definition tab and select Copy of current product.

2. Change the Product name to PET Bottle (Recycled)

3. Change the Recycled content value for PET to 35%
a) Click in the box to manually type in a value.

4. Generate the Summary chart.
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The first life energy (not including EoL potential) is reduced by 11%.

Note: The Summary chart can be copied into a document or printed using Copy and Print at the top of
the chart window.

8.3. Exercise 22: Saving and exporting
Eco Audit product definitions and reports do not form part of a selection project, and need to be saved separately.

1. Save your product definition

2. Generate an Eco Audit Report
a) Click the Report tab (or click Detailed Report on the Product definition tab).

3. Export the report as a PDF
a) Click the disk icon at the top of the Report tab, and select PDF.

You will require a PDF reader such as Adobe Reader to view the exported report.
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9: Synthesizer tool

Note: TheSynthesizer tool is onlyenabled in theadvancedLevel 3databases (e.g.Level 3 Eco Design). The toolbar
iconwill begrayedout if youhaveopenedanyof thedatabasesavailable inGranta EduPack Introductory, including
Level 3.

The Synthesizer tool is designed for use in the early stage of product development. It consists of three types of model:
hybrid models, for estimating the performance of novel materials and structures, Part Cost Estimator, for calculating the
cost of a component based on thematerials and processes used, and Battery Designer, for comparing early-stage battery
module and pack designs.

Synthesizedrecordsproducedusing theSynthesizer tool canthenbecomparedwithexisting records in theMaterialUniverse
database using selection stages.

9.1.Exercise23:Modelhybridmaterialswith theSandwichPanelsmodel
Hybridmaterials and structures combine thebenefits of twoormorematerials toproducenewmaterials that exhibit
unique combinations of properties. For example, both composite materials and sandwich panels are commonly
used to create strong, lightweight structures.

1. You will need to use an advanced Level 3 database for this exercise.
a) Change the database to Level 3 Polymer.

2. Plot Young’s modulus (E) against Density (ρ) using the MaterialUniverse: All bulk materials subset
As in Exercise 6: Create a bubble chart on page 14.

3. Use the Sandwich Panels model to create synthesized records for a family of hybrid materials
a) Click Synthesizer on the toolbar (or click Tools > Synthesizer on the menu bar).
b) Select the Sandwich Panels – Balancedmodel.

4. Set the Source Record values

Aluminum, 6061, T6 (wrought)Face-sheet

Polymethacrylimide foam (rigid, 0.200)Core

Click Browse and locate the records in the browse tree.

5. Keep the default values forModel Variables andModel Parameters, and set the following Record Naming
values:

AlFace-sheet

RohacellCore
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6. Create the synthesized records
a) Click Create and then Finish. The new synthesized records are shown in the Results list and on the Chart

Stage.

Note: Click theblueHelp iconorpressF1 in theSynthesizer tooldialog toview further informationabout
the current model type, including details of the calculations used.

7. Plot an Index line corresponding to a lightweight, stiff panel in bending: E1/3/ρ

a) Click Index anddisplay lines, enter a slope value of 3, and selectmaximize the index. Click the plot area
to place the index line, then click and drag to change its position.

8. Add labels to the source records and some of the synthesized records
a) You can click individual records on the chart and drag to place a label.
b) Youcanalsoadd labels fromtheResults list: select oneormore records in the list, right-click andselectLabel

on the shortcut menu, then drag the labels where you want them on the chart.

c) Click Highlight synthesized records to help you identify the synthesized records on the chart.

d) Use the Zoom controls and to zoom in to the area of interest on the chart.

9. Navigate to your synthesized records in the Browse panel

Synthesized records appear on the browse tree underMyRecords andmay be edited or deleted in a similar way
to User Defined records.
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10. Delete the Chart Stage

9.2. Exercise 24: Part Cost Estimator
The Part Cost Estimator is a Synthesizermodel that calculates the total cost of a component based on thematerial
and processing costs.

Note: You will need to use an advanced Level 3 database for this exercise

1. Use the Part Cost Estimator to compare the cost of a component whenmanufactured as an injection-molded
polymer, or a rolled and pressedmetal

a) Click Synthesizer on the toolbar. In the dialog, select Cost – Part cost estimator.

2. Enter the Component Details for the first component

PP (copolymer, 20% talc)Material

10%Value of scrapmaterial

6.4Part mass

10Part length

1000 - 1E6Batch size

10Number of values

For this exercise, the units of part mass and part length do not matter.

3. Enter the Primary Shaping Process values

Injection molding (thermoplastics)Primary process

Custom formAvailability

StandardPart complexity

Use the default values for Load factor,Overhead rate, and Capital write-off time.

4. Set the Record Naming values

PPMaterial
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moldedPrimary process

5. Create the new records
a) Click Create. Keep the Part Cost Estimator dialog open.

6. Enter Component Details for the second component
a) In the Part Cost Estimator dialog, click Previous and change the Component Details:

YS170 hot rolled (a high strength, drawing quality steel)Material

10Part mass

Use the existing values for scrapmaterial value, part length, batch size, and number of values (these are
retained from the first material processing chain input).

7. Enter Primary Shaping Process values

Hot shape rollingPrimary process

Use the existing values for the remaining properties.

8. Enter details for the Secondary Shaping Process
a) Select Include secondary process, and enter the following value:

Press formingSecondary process

Use the default values for Part complexity, Amount of scrap, and Scrap recycled.

9. Enter the Record Naming values:

SteelMaterial

rolledPrimary process

pressedSecondary process

10. Click Create and then Finish to create the records and close the Part Cost Estimator

Synthesized records created using Part Cost Estimator are appended to the MaterialUniverse browse tree under
My records > Synthesized > Part cost estimator.

11. Create a bubble chart to compare the twomaterial processing chains
a) SelectMaterialUniverse: All bulk materials, click Chart/Index, and set the following x- and y-axis values:

Part cost estimatorCategory

Batch sizeX-Axis Attribute

Part costY-Axis Attribute

12. Change the Record color for easy comparison of the two processing chains
a) Navigate toMy records > Synthesized > Part cost estimator. Right-click the PP, molded subfolder, click

Record color, and click a color to change the record color for all records in that folder.
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13. Delete the Chart Stage

9.3. Exercise 25: Battery Designer
Battery Designer is a Synthesizer model that estimates the performance of batterymodule and pack designs based
on the materials, battery cell type, and thermal management system used.

Note: You will need to use an advanced Level 3 database for this exercise

1. Create a bubble chart to compare individual battery cells.
a) On the Chart/Select panel, Select from: Battery Cells: All Cells.
b) Click Chart/Index and set the following x- and y-axis values:

GeneralCategory

Specific powerX-Axis Attribute

Specific energyY-Axis Attribute
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Charts of Specific energy against Specific power are also known as Ragone plots.

By default, this will display all cells in the Battery Cells table, as well as any synthesized Module and Pack
records in the Selection Project.

2. Use the Battery Designer to estimate the performance of an example multi-cell module configuration

a) Click Synthesizer on the toolbar. In the dialog, selectBattery Designer - Cell toModule (by number of
cells).

3. UnderModule, enter the name and battery cell type

Test Module 1Name

Lithium-ion (NCA) Cylindrical 3500 mAhBattery Cell

4. Set the Number of cells and target Discharge Current

10Number of cells in series

2Number of cells in parallel

7ADischarge current

5. Select a custom Configuration
a) Check the Custom configuration check box.
b) Make sure theOr pre-definedmodule check box is not selected.

6. Set Packagingmaterials and dimensions:

PC (high viscosity, molding and extrusion)Casingmaterial

3 mmWall thickness

PC foam (rigid, closed cell, 0.65)Insulationmaterial

3 mmInsulation thickness

1 mmCell spacing

7. Select a Thermal management system (TMS)

Passive air coolingCooling system type

8. Click Create and then Finish to create the synthesized record and close the Battery Designer
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Synthesized records created using Battery Designer are appended to the Battery Cells table under My records
> Synthesized >Modules.

9. Go back to the bubble chart
The newModule record is now displayed on the Ragone plot.

10. Now create some Module records based on desired performance, and compare them to the existing Module

a) Click Synthesizer and in the dialog, select Battery Designer - Cell to Module (by performance).

11. Enter theModule details:

Test Module 2Name

Lithium-ion (NCA) Cylindrical 3500 mAhBattery Cell

12. Set the target Performance:

60-240 minShould last for at least

10Number of values

7 Awith Current

36 Vand Voltage

13. Select custom Configuration
14. Set the Packagingmaterials and dimensions:

PC (high viscosity, molding and extrusion)Casingmaterial

3 mmWall thickness

PC foam (rigid, closed cell, 0.65)Insulationmaterial

3 mmInsulation thickness

1 mmCell spacing

15. Set the Thermal management system (TMS)

Passive air coolingCooling system type

16. Create Module records
a) Click Create and then Finish.

17. Compare Module records using the bubble chart

All the synthesized Modules can now be compared with each other and with individual cells.

You can also open Module datasheets to view other calculated properties associated with that module, for
example predicted operating temperature and discharge time.
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To reproduce this chart:

• Set Lithium-ion (NCA) Cylindrical 3500 mAh as the Reference record.

• Select Highlight Synthesized Records and Highlight Reference Record on the Chart toolbar.
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